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Introduction 

CueTimer is a timer-software for conferences, broadcasting, gameshows, or 

any event that requires precise timing and planning. Display the counter on a 

screen connected to the mac, through the local LAN network or over the 

Internet. The operator can place the timers in a Cue list and use simple 

shortcuts to move forward during the event. 

 

1. Preparations 
 

1.1 Minimum requirements 

- A Mac with Mojave, Catalina, or Big Sur OS. Both Intel and Apple Silicon CPUs 

are supported natively. 

- Internet-connection when activating license for the first time.  

 
1.2 Connections 

 

 Monitor-output  

Connect Mac to a monitor and put the monitor as extended screen. Now you 

can display the counter on the external monitor 

 

 NDI 

With NDI you can send the counter-window to another device on the same LAN 

network. This requires that the mac with CueTimer and the receiving device are 

on the same local network.  

 

 Webpage 

If you have internet-connection you can send the counter and schedule to a 

webpage that is hosted by our webserver. 

 

1.3 Installing the license 

When the program starts for the first time it will enter trial-mode. In this mode 



the program will work normally for 10 minutes and then close. To use the 

program without restrictions, a license must be installed. Licenses can be 

bought from our website www.presentationtools.com/store. 

To install the license, copy the license-key to the activation-menu and push 

“activate”. Activation requires internet-connection. 

This menu can be accessed when starting the program in trial mode. On the 

first popup-menu, push “activate”, then follow steps above. 

 

 

 

2. Getting started 
Here we will show a simple way to use the program with 3 countdown-timers.  

 

After installing the licence (or in trial mode) the program-interface will look like 

this:  

 

 
Create new timers with the “New” button. 
Set the name and countdown-length, then push enter or 

the green button.  

Repeat this until you get the 3 timers. 

 
 
 

 
Now you will have a list of timers that are ready to start. We refer to this list as 
the Cue List.  

 
  

https://presentationtools.com/


 
 
The next step is to activate the counter-windows. This is where the countdown 
will be shown for your audience. You do this from the “View” tab in the top 
menu-bar..  

                 
 
 
To start the first countdown, push the “Fire next” button 
 

 
The first timer in the list has changed its color to red. This means that this timer 
is running and displayed in the counter-windows. Push Fire again to start the 
next timer in the list, or push Cue Next if you want to move forward without 
starting a new timer.  

 
 
 
 

3. Displaying the counter-windows 
All the counter-windows are accessible from the “View” tab in the top menu 
bar 

                            
 
3.1 Local outputs 
Fullscreen monitor-output 

This will display the counter on the external monitor. If you want to manually 

assign the monitor on which the countdown will display, do this from the 

“fullscreen monitor” dropdown menu.  



Preview-window 

This is a free-floating window that is a copy of what is shown in the fullscreen-

monitor. It can be scaled and placed anywhere you like. Use this as a monitor 

to see what is happening on the fullscreen. 

NDI 

Activate the NDI output 

 

3.2 Web display 

Push the Web Display button to open this menu:  

 
From the Web Display menu push “Generate new link” to create this page. 

Distribute this adress to those you would like to access this page.  

You can always delete this page and create a new. We recommend that you do 

this for each event with new groups of people. Pages that are deleted will no 

longer receive data from the CueTimer application.  

 

4. Create new timers 
 

4.1 Open timer window 

Push “new” button or shortcut  

command + n. In the “New Timer” window, 

write the name and edit the duration. (Tip: 

Use “tab” key to move forward in the 

window) Push “enter” or green button. 

 
 
 
 
 
 



4.2 Options for new timers 

 

Name 

Name or description of the timer 
 

Different timer-types 
There are 5 different timer types you can choose from 
  

Countdown - Timer will count down from the time set on “duration”  

End Time - Timer will count down to the time of the day set in «Time Finish” 

Count up - Timer will count up from 0 

Clock - Timer will display clock 

Empty - Timer will display nothing 
 

Duration/End Time 
“Duration” can be set for countdown-timers. This will be the total duration that 
the timer will count down from. For end-time timers you can set the end-time 
value (time of the day). When the end-time timer starts, it will count down to 
the end-time value. 
 

Start 
When start is “on”, you can either: 
With autostart “off”: Set a tentative value for when the timer should start 
according to the schedule. This will be shown in the web-schedule. 
With autostart “on”: Timer will automatically start when the start-time value is 
reached.  
 

Warning 
For countdown and end-time timer types, set the threshold for when warning-
style will begin. When this value is set to 0, warning-style will not be shown.  
 

End action 
For countdown and end-time type timers, choose what will happen when time 
has run out. 
Stop – Timer will stop at 0 
Overtime- Timer will continue. (+ 00:00:01) 
Repeat- Timer will repeat (same as pushing “repeat” button) 

Fire Next - “Fire Next” command (same as pushing “fire next” button) 

Cue Next - “Cue Next command (same as pushing “cue next” button) 



When you have created several timers, the Cue List will look something like 
this: 
 

 

 

 

 

5. Web schedule 

The webpage created by CueTimer allows you to view the CueList as a 

schedule. The list in the previous chapter will look like this on the webpage: 

 
The web-schedule will display the name, start-time and duration as an ordered 

list starting with the timer set to fire next. When hovering over this page with 

the mouse, a button top right of the page will let you toggle between the 

counter and the schedule page. It is synced to the CueTimer app so that every 

change in the Cue list is automatically updated in the web-schedule.  

 

 

 
6. Using the program - Starting and stopping timers 
 
6.1 Colors in the Cue List 
Timers in the Cue List can have different colors attached to them depending on 
what their status is: 
 

 
Green/grey color means that the timer is next in line to be started 
 



 

 
Red color means that this countdown has started and is displayed in the 
counter-windows 
 
6.2 Rules for what is displayed in the Counter-Windows 
The timer in red will always be shown in the Countdown-Windows. If there is 
no red timer, the green timer will be displayed. If the «Blackout» or «clock» 
button is enabled, then this will override what is in the cue list. 
 
6.3 Using the commands 
The buttons to the left in the top menu-bar are explained below. They will all 
affect what is shown in the Counter-windows.  
 

 
 

  “Fire” button (shortcut: spacebar) 
This starts the next countdown. The timer previously in green will now change 
color to red. The new timer in green is the one below the new red. 
 

Single Timer Mode   
When turned on, the behavior of the fire-
button and command changes: the next timer 
will stay the same. The next time the “cue next” 
button is pushed, the current timer will reset 
and be ready to run again. This mode is great 
for repeating the same timer many times, or in 
situations where there is no chronological list of 
timers that you want to play.  

 
 
 

  “Cue Next” button (shortcut: command + enter) 
When the first presenter/act is done, you can push button “cue next”. This will 
display the next timer but not start it. Next time you push “fire” this timer will 
start. The use of “cue next” is optional, you could also just use the fire-button 
to start the next timer without cueing it first. Pushing this button twice will 
reset all timers in the Cue List.  
 



Holding down SHIFT-key while pushing the “Cue Next” button will reset and 
cue the current timer in red without starting it. It is an easy way of repeating 
the same timer instead of moving forward in the list.  
(Shortcut: SHIFT + Command + Enter) 
 

 “Pause” button (Shortcut: Command + p) 
This will pause the counter. It only applies to the timer currently in red. 
 

 “Restart” countdown (Shortcut: Command + r) 
This will restart the counter. It only applies to the timer currently in red. 
 

 “Undo” button 
This is an undo-button for starting timers: In case the fire-button is accidentally 
pushed twice, this button will continue the previous started timer. It only 
applies if there is still another timer running in the project apart from the timer 
in red. 
 
 

 

 

7. Manipulating time in the Counter-windows 

 

 
+ and – buttons 

This will add or subtract 1 minute to the countdown.  

100% field 

Changing this number will increase or decrease the speed of the countdown by 

this percentage.  

 

You can also change these values from the Cue list, by editing Duration, End or 

Speed.  

 
 

 



8. Speed 

The idea behind “speed” is that the operator can manipulate the time left 

without the change being visible to the speaker. In the example above, speed 

has been changed to 110% in the top timer (John). This has shortened the total 

duration and pushed “time finish” forward, but the only change in the visible 

countdown is that the countdown will go slightly faster. We recommend using 

this feature with caution, and not to go below 80% or above 120% as going 

outside these numbers can make the speed-change too obvious in the 

Countdown-Window. 

 

9. Messages 

 
 
It is possible to display short messages in the Countdown Window. Push the 
edit message button to open the message-menu 
Use the text-field to write your message. Push “show” to display it. Button will 

turn orange. Push this button again to hide message. “Clear” button will clear 

the text-field. 

 
 

 

 

 

 



10. View-buttons 

 
These buttons will override data from the Cue List and take over what is shown 

in the counter-windows.  

 “Blackout” 
Display black screen  
 

       “Clock” 
            Display the clock 

 

 
 

 
11. Editing the Cue List 
 
11.1 Selecting timers for edit 
To select a timer for edit you can mouse click it or navigate with the playlist 
with the arrows. The color in the left column will change to blue.  

  
 
To choose more than one timer, mouse-click while holding down the shift-
button.  
 
11.2 Using the edit-buttons 
 

 
 

   “New“button (shortcut: command + n)  
Creates a new timer 
 

   “Delete” button (shortcut: command + delete) 
Delete the currently timer(s). Exception: It is not possible to delete a timer in 
red. 



 
   “Copy” button (shortcut: command + c) 

Copy the selected timer(s) 
 

“Paste” button (shortcut: command + v) 
Paste the timer that has been copied. The timers will paste below the selected 
cell. 
 

  “Set Next” button (command-click on timer) 
Makes the selected timer the green timer.  
 

 “Reset” button 
Use the reset-button to put the timer(s) that are not in red back to initial state. 
This command can also be done by pushing the Cue Next button twice. 
 
11.3 Moving timers 
You can move timers with drag & drop. Select timers with the mouse and hold 
down the button, then move them to a new position and release the button.  

 

11.4 Editing cells in the Cue list 
Most of the cells in the Cue List are available for edit. To select a cell for edit, 
push on it twice with the mouse or use the arrows to select and then push 
enter. 

  
 
 
11.5 Importing and exporting the Cue list 

 

From the “File” menu you can reset, import and export the Cue list you have 

created.  

 

 



12. Preferences menu 

The Preferences-menu can be accessed from the top menu-bar. Here you can 

customize the style and looks of the counter-windows, configure NDI,  and set 

up OSC-triggers.  

 
 

12.1 Applying changes 

When editing this menu the changes are not automatically stored.  To apply 

changes and make them visible, push “command + s”, or push the “Apply” 

button on the bottom right corner.  

 
 

12.2 Style 

 
You can customize how the counter-windows appear from the Style settings. 

This is divided into 5 horizontal tabs. To the left you find the General settings. 

The options for “display hours” and “display seconds” are useful for making the 

counter and the clock take less space in the Counter-Window.  

 

 

12.3 Local monitor 

 



Here you can set the size, 

location and font of the 

content in the Preview, 

Fullscreen and NDI windows. 

They will have identical 

properties except size and the 

NDI-output is always 16:9.  

 

 

New in v.2.2: The Crop & Scale settings will make the content only use part of 

the screen. This is useful for Picture in Picture settings. The background key 

color will set color for the area that is outside of the content. For chroma-

keying, you would normally set this color to green. This color also has 

transparency which translates to an alpha-channel on the NDI-output and 

transparency for the monitor-output.  

 

 

 

12.4 Web display 

You get separate options for 

size and positions for the web-

display. The content will react 

dynamically to changes in the 

browser-size so that it should 

look good on any device.  

On the bottom you find settings 

specific to the schedule-page.  

 

 



12.5 Progress bar (New in v.2.2!) 

 

Here you set the style for the progress-bar which is available for the local 

monitor outputs.  

12.6 Colors & Animations 

The text and numbers can have different colors and animations depending on 

the state of the counter. For example, in the default template, when the 

counter runs out, the background turns red and the numbers flash. 

Normal 

Countdown is in “normal-mode” when it is red and running and has not yet 

reached “warning” or “overtime”. 

Pause/Cue Next 

When the counter is paused, or the Next(green) timer is in Counter-Windows, 

these values will be shown. 

Warning 

When countdown reaches the time set here, the style will change from normal 

to warning. 

Overtime 

Timer reaches overtime when the countdown has no time left. 

 

 

 



 

 

12.7 Settings for NDI 

Here you can set the resolution and 

framerate for the NDI output.  

By default the NDI will use the “Public” NDI 

which means that it is easy to discover this 

signal for other NDI-devices on the network. 

With custom groups you can control where 

you want the NDI- video to be discovered.. 

Then the receiving device has to look for this 

same group in order to recieve ndi-video sent from CueTimer 

! Note that CueTimer will disregard the settings of the software Access 

Manager. Access Manager does not control the group-settings of CueTimer. 

At the moment it is not possible to use CueTimer with NDI Discovery servers on 

Windows and Linux computers. This is due to limitations of the NDI 5 SDK 

library.  

 

 

 

12.8 Triggers- Configure OSC-commands sent from CueTimer 

The second tab in Preferences-menu sets the OSC-commands sent from 

CueTimer. 

OSC-commands can be sent from 

CueTimer on 5 events: 

- when a new timer is fired 

- when the current timer reaches the 

overtime-treshold 

- when the current timer ends 

- Cue Next command is performed 

- end time of the current counter sent as 

an OSC-string. 

The OSC-commands and addresses can be user-defined from the menu. 

 



 

12.9 Export, import and reset settings 

On the top of the menu, you will find buttons which are explained below 

 

Export 

Saves the current settings as a file that can be imported again. 

 

Load 

Loads a file of previous settings 

 

Reset 

Puts menu back to initial state 

 

13. Trigger CueTimer with OSC-commands 

 

You can trigger commands in CueTimer through OSC. This allows you to start 

and control timers from external devices and software like Qlab, Resolume and 

Mitti. OSC can be sent over the local LAN-network.  

Port and IP-adress 

4779 is the port used for incoming OSC. Make sure that this port is not blocked 

by a firewall.  The OSC-message sent to CueTimer must use this port along with 

the IP-address of the computer using CueTimer. If you want to send OSC from 

another software on the same machine, then use the Localhost address 

127.0.0. 

 

Commands 

Global commands 



These commands from the program-interface can be triggered with OSC: 

 

 

The OSC-adresses for the global commands are shown below. These commands 

can have any type or argument, they will still work. For simplicity we still 

recommend that you use string, float, or integer type commands.  

 

Description OSC-path 

FireNext /global/fire 
CueNext /global/cue 

Pause /global/pause 
Restart /global/restart 
  

 

Individual timer-commands 

You can also fire and cue individual timers in the Cue list. To do this you first 

have to use the ID-field in the CueTimer Cue list to set a unique ID for the timer 

you want to trigger. Then you will use this same ID in the OSC-path to trigger 

this timer.  

There are two actions you can trigger with individual timers: 

Fire 

The timer will start from the beginning. (If you send the command twice the 

timer will restart.) 

Cue 

The timer will be set as the next to fire the next time the fire-button is pushed.  

In the example below, if we receive an osc-command to fire the timer with ID 1 

 

 

Then: 



 

 

 

From the first image, if we instead send a command to set 1 as cue, then: 

  

 

 

Below are the OSC-addresses used for triggering individual timers. Replace {id} 

with the ID used in the ID-field in CueTimer 

Description OSC-path OSC-type OSC-argument 
Fire timer /timer/fire String {id} 

Cue timer(set 
next) 

/timer/cue String {id} 

 

! CueTimer will not accept # in the id-field. If the sign # is used as a part of the 

argument and ID, the OSC-message will simply not work. Also, the OSC-

protocol does not allow spaces in the argument-field. So instead of having an ID 

called “keynote speaker”, you could name it “keynote_speaker”. 

 

 
14 Control CueTimer with Companion 
 



 
Companion is an open-source software that lets you control multiple devices 
through the local network. It is possible to connect a Stream Deck box with 
buttons for better hands-on operation, or you can use a web-browser.  
For more info and download-links, please go here: www.bitfocus.io  
 
 
14.1 Companion compatibility 
Companion v.2.2 has all the latest commands for CueTimer 2. Companion v.2.1 
also has a CueTimer module, but some of the features are missing.  
 
14.2 Connect Companion and CueTimer  
Make sure that CueTimer and the Companion software are on the same LAN-
network.  
 
1. Open Companion and CueTimer. (Which order doesn’t matter) 
2. Go to Companion settings and add CueTimer module.  The easiest is to use 
the search-field. If the module can’t be found it means that you need a newer 
version of Companion. 
 

 

 

3. Set the correct IP-adress for CueTimer 

If CueTimer is on the same mac as Companion, then you can use the Localhost 

address 127.0.0.1. If they are on separate machines you will need to find the IP-

http://www.bitfocus.io/


address of the Mac running CueTimer and plot this into the Target IP.  

CueTimer uses port 4778 for communicating with Companion. Always use the 

default target-port. 

 

 

4. Check connection 

If CueTimer is open and connection between the apps then the status will be 

OK.  

 
Troubleshooting: If status is not OK, or commands cannot be sent, you can 

check: 

- LAN connection between CueTimer and Companion 

- Firewall settings. Port 4778 must not be blocked.  

 

 

 

14.3 Add buttons 



We have made presets that you can drag and drop to the button layout-page. 

All commands and feedback are available from here.  

 

You can also import the commands and customize 

through the regular button-menu. 

 

 

 

 

14.4 Use the commands 

When everything is set up you can view the counter and execute all of the 

commands from the button-bar in CueTimer using the Companion web-

emulator or a Stream Deck device.  

We also included buttons for activating outputs and select Single Timer Mode. 

From the Preset-menu these buttons will lit yellow when they are on:  

 

 

Some new commands are only available through Companion: 

 Move up and down 
This will move the assignment of the next(green) timer.  
 
Before move down: 



 
 
After: 

 
 
 

  Trigger individual timers 
The “Fire” and “Cue” presets will let you trigger individual timers to start or set 
as next. This works very similar to OSC-triggering mentioned earlier in this 
chapter.  

 
From the Companion menu, set the 
ID of the timer that you want to 
trigger. Then this must correspond to 
a timer in CueTimer with identical ID.  
 
 

After pushing this button in Companion, the timer with ID “1” will start.  

 
 
Feedback on ID-buttons 
When using the presets the buttons will have background-color depending on 
the status of the timer, and name of the timer on top. So, when the timer is 
running it will look like this:  

 
 
From the button-menu you can also change so that you see the duration of the 
timer instead of the name. Then the button will look like this: 

  

  
 
 



14.5 Feedback-buttons 
 
Along with the commands you can also have buttons that only shows the status 
of CueTimer. These can be chosen from the feedback-page in the presets or 
selected manually from the button-menu. The top row in the feedback presets 
shows info for the timer that is currently displayed in the counter-windows. 

 
The counter and name will use the same text and background-color as the main 

counter-window. (Except name-color follows counter-color). These colors can 

be set using the Preferences menu in CueTimer 

 

We also have feedback for what is the the next/green timer.  

 
 

 
 
 
15. More info 

 
Website: https://presentationtools.com/ 
We also put some instructional-videos on our Youtube-channel:  
https://www.youtube.com/channel/UCTqGREnR9V4keDzRjyDmujg 
 
Contact: 
info@presentationtools.com 
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